Stellar Phoenix OLM Repair 2.0
Technician

User Guide



Overview

Stellar Phoenix OLM Repair - Technician is designed to repair corrupt Outlook backup (OLM) files.
OLM files contains back up of mailbox items such as mails, address book, calendar, notes, and tasks.
After repairing, the OLM file can be saved in the desired format (.rge, MBOX, EMLX, EML or HTM) at any

user specified location. User can view saved files using their respective application.
The software also shows the preview of mailbox items - mails, address book, calendar, notes, and tasks.

What's new in this version:

¢ New and enhanced GUI.

Supports MS Outlook 2016.

Option to save a particular folder after repair.

Option to find OLM file from your computer's drive and folders.

Option to save repaired file in MBOX, EMLX, EML and HTM format.
Key Features:

e Preview and repair E-mail.

e Preview and repair Address book.

e Preview and repair Calendar.

e Preview and repair Notes.

e Preview and repair Tasks.

e Supports MS Outlook 2016 / 2011.



Installation Procedure

Before installing the software, ensure that your system meets minimum system requirements.
Minimum System Requirements:

e Operating System: Mac OS 10.7 and above

e Memory: 1 GB RAM

e Hard Disk: 55 MB of free space

e Microsoft Outlook 2011/2016

Steps to install:

To install Stellar Phoenix OLM Repair - Technician, follow these steps:
e Unpack StellarPhoenixOLMRepair-Technician.dmg.zip file.

o Decompressing the zip file and double click the dmg file. This step will mount a virtual volume -

StellarPhoenixOLMRepair-Technician.

e Double-click StellarPhoenixOLMRepair-Technician volume to open Stellar Phoenix OLM

Repair - Technician application window.
e Drag Stellar Phoenix OLM Repair - Technician file to the Applications folder.

e To launch the software, double click on Stellar Phoenix OLM Repair - Technician file in

Applications folder.

e This displays License Agreement. If user accepts the License Agreement, then the software is

launched; otherwise, it terminates.

To remove the software, drag and drop the Stellar Phoenix OLM Repair - Technician file from

Applications folder to Trash.



Launching the Tool

Follow any of the following methods to run Stellar Phoenix OLM Repair - Technician on a Mac system.
e Double click on Stellar Phoenix OLM Repair - Technician in Applications folder.
e Double-click on Stellar Phoenix OLM Repair - Technician desktop shortcut (if it is created).

e Click on Stellar Phoenix OLM Repair - Technician icon in the dock (if it is created).



User Interface

Stellar Phoenix OLM Repair - Technician has a very easy to use Graphical User Interface.

After launching the program, you will see the main user interface as shown below:

Stelar Phoenix OLM Repair-Technician
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To repair a corrapt OLM File, foliow the steps mentloned below -

1. Click "Browse’ bulton to select cornapt QLM file,

2. Click "Scam Mow" Butiom 10 iniclate repair process.
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The user interface contains menus and buttons that allow you access various features of the software with ease.



Menus

StellarPhoenixOLMRepairTechnician

About StellarPhoenixOLMRepairTechnician JZICEERYT

StellarPhoenixOLMRepairTechnician About StellarPhoenixOLMRepairTechnician

Use this option to read information Services >

about Stellar Phoenix OLM Repair -
Hide StellarPhoenixOLMRepairTechnician 8H

Hide Others L 3$H
Quit Show All

StellarPhoenixOLMRepairTechnician

Technician.

Quit StellarPhoenixOLMRepairTechnician  #Q

Use this option to quit Stellar Phoenix

OLM Repair - Technician.

File

Open m View Tools

Use this option to select an OLM file for repair. Open E
Save #ES

save Find File  $F

Use this option to save a repaired OLM File.

Find File

Use to option to search for an OLM file in any

drive.

View

Mail Tools Help

Use this option to preview the mails. Mail 31
Address Book 382

Address Book Calendar ap3

Use this option to preview the address book. Notes #4
Tasks 365

Calendar

Use this option to preview the calendar.



Notes
Use this option to preview the notes.
Tasks

Use this option to preview the tasks.

Tools

Register

Use this option to register the software after

purchasing the software.
Transfer

Use this option to transfer the license of the

registered software to another computer.

Help

Help Topics m

Use this option to view Stellar
Phoenix OLM Repair - Technician

help manual.

Order Stellar Phoenix OLM Repair -

Technician

Use this option to buy Stellar Phoenix
OLM Repair - Technician software.

Email to Stellar Support

Use this option to mail for support
against any problem.

View Support Section

Use this option to visit support page of

ol

Register

Search |

Help Topics...
Order Stellar Phoenix OLM Repair

Email to Stellar Support

View Support Section

Submit Enguiry

View Knowledge Base Articles


http://www.stellarinfo.com/email-repair/olm-repair/buy-now.php
mailto:support@stellarinfo.com
http://www.stellarinfo.com/support/

stellarinfo.com

Submit Enquiry

Use this option to submit enquiry to
stellarinfo.com

View Knowledgebase Articles

Use this option to visit knowledgebase

articles of stellarinfo.com



http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/

Buttons

Stellar Phoenix OLM Repair - Technician has following buttons / options:

&

Find OLM

Mail
Click this button to preview the mails.

Address Book

Click this button to preview the address book.

Calendar

Click this button to preview the calendar.

Notes

Click this button to preview the notes.

Tasks

Click this button to preview the tasks.

Open
Click this button to select an OLM file for repairing.

Save

Click this button to save the repaired OLM file.

Find OLM

Click this button to find any OLM file.

Scan Now

Click this button to start the repairing process.



Ordering the Tool

To know more about Stellar Phoenix OLM Repair - Technician click here.

To purchase the software online, please visit http://www.stellarinfo.com/email-repair/olm-repair/buy-

now.php

Once the order is confirmed, a pre-paid registration key will be sent through e-mail, which would be

required to register the software.


http://www.stellarinfo.com/email-repair/outlook-mac-repair.php
http://www.stellarinfo.com/email-repair/olm-repair/buy-now.php
http://www.stellarinfo.com/email-repair/olm-repair/buy-now.php

Registering the Tool

The demo version is just for evaluation purpose and must be eventually registered to use the full
functionality of the software. The software can be registered using the Registration Key which you will

receive via email after purchasing the software.
To register the software:
1. Run demo version of Stellar Phoenix OLM Repair - Technician software.

2. On Tools menu, click Register option. Register window is displayed as shown below.

(=] < Register

To complete the registration process, select one of the options given
below :

© | don't have the registration key

| have the registration key

Cancel  |NOKEN

3. Choose 'l don’t have the registration key’ (Use this option if you have not purchased the product) or

select 'l have the registration key’ (Use this option if you have already purchased the product).
To register the software, when you do not have a registration key, follow the steps given below:

1. In the Register window, select 'l don't have the registration key' option. Click OK, to go online and

purchase the product.

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of

purchase.

3. In the Register window, type the Registration Key and click Register button (Please ensure that

you have an active Internet connection).



[ EaN ] Oniline Aegistration

Enter the Registration Key and click the ‘Register button. The program automatically connects
to the server to register the product.

Registration Key - |3000(-X000- 0000000 X000 X000 Register

Mote: Flease ensure you hive 3 working internet connection for anline activation.
‘Where is my registration key?

The registration key has been sent to you through email by our payment gatewsay, after
successful purchase of software.

Registration key is sent 1o the same email id, which you specified in your purchase derails,

Cancel

4. ' Activation Completed Successfully ' message is displayed after the process is completed

successfully. Click OK.
To register the software, when you have a key, follow the steps given below:
1. Inthe Register window, select 'l have the registration key' option.

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) or
'Offline Registration' (Use this option to register the software manually / through e-mail if for any

reason, Internet connection is unavailable).
¢ Online Registration
Online Registration is possible only when an active Internet connection is available.
o To register the software online:
1. From the Register window, select Online Registration. Click OK.

9 Register

To complete the registration process, select one of the options given
below :

I don't hawve the registration key

D | have the registration key

D Online Registration Offline Registration

2. An Online Registration dialog box will appear.

3. Type the Registration Key (received through email after purchasing the product) in the field of
Registration Key. Click Register.



[ EaN ] Oniline Aegistration

Enter the Registration Key and click the ‘Register’ button, The program automatically connects
to the server 1o register the product,

Registration Key 0 = R =X = 00K = IO - 0 Regisier

Mote: Flease ensure you hive a working internet connection for onling activation.
‘Where is my registration key?

The registration key has been sent to you through email by our payment gateway, after
suctessful purchase of software.

Registration key is sent to the same email id, which you specified in your purchase details,

Cancel
The software would automatically communicate with the license server to verify the entered key.
If the key you entered is valid, software will be registered successfully.
Offline Registration

Offline Registration enables you to register the product when your computer does not have an

Internet connection.
To register the software offline:
From the Register window, select Offline Registration. Click OK.

® O Register
To complete the registration process, select one of the options given
below :

1 don't have the registration key

© 1 have the registration key

Online Registration ° Offline Registration

An Offline Registration dialog box will appear displaying Registration ID in its respective field.
Offline Registration

You need bo send below Ested 'Registration D" to "Stellar Technical Support' to get your
‘Licensa Kay'. If you have already received your License Key', anter it and chck
Ragister buthon 10 register the produect.

Registration 1D 1E3A344Y TOLNEKEP-FLTEAE TRINDO(EZX-AED YON YIATEEXEGM-1A32

License Ky

carcel



3. To get your License Key, which is required to register the software manually, you need to mail the
listed Registration ID to support@stellarinfo.com.

4. A License Key will be sent to your email address after verifying the Registration ID and purchase
details by Stellar Technical Support.

5. After receiving the License Key, open Stellar Phoenix OLM Repair - Technician. In Register

window, select 'l have the registration key"'.
6. Select Offline Registration and click OK.

7. Enter the License Key received through email in the field of License Key.

Offline Registration

You nead bo send below Ested "Registration 1D to "Stellar Technical Support’ ko gat your
Licensa Kay', If you have already received your ‘License Kay', enter it and chick
Rogister buthon 10 register the produest.

Registration D0 1B3A344Y TOLNEKBR-FLTEAETFIMMSEZN- AEDYONYIATAEXBGEM-1432

License Key. R YR B N 3

Cancel [ Regiian )

8. Click Register to activate the software. A confirmation message is displayed if a valid key is
entered. Click OK.


mailto:support@stellarinfo.com

Transfer License

Stellar Phoenix OLM Repair - Technician allows you to transfer the license of the registered software to
another computer on which you want to run the software with full functionality. This operation deactivates

the product on your current computer so it can be reactivated on the new computer.

To transfer a software license from one computer to another, please follow the specific steps

below:

On Target Computer:

1. Run demo version of the software.

2. InTools Menu on Menu Bar, click Register. A new dialog appears.

3. From the Register window, select Offline Registration. Click OK.

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field.

Offline Registration

You nead bo send below Ested "Registration 1D to "Stellar Technical Support’ ko gat your
Licensa Kay'. If you have already received your Licanse Kay'. enter it and chick
‘Ragister bution 1o register the product.

Registration D0 1B3A344Y TOLNEKBR-FLTEAETFIMMSEZN- AEDYONYIATAEXBGEM-1432

License Key:

On Source Computer:
1. Run registered version of Stellar Phoenix OLM Repair - Technician software.

2. In Tools Menu on Menu Batr, click Transfer License.



Transfer Licenze

To transfer the license of the program, copy the Registration ID from the target
computer and paste (t below. Click on "Transfer In™ to generate a License Key which
needs 1o be pasted in LArgel computer,

Registration ID: ||

License Key :

Cli | " ¢ ferring i I

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the

Source Computer.

4. To get your License Key, click Transfer In button on Source Computer. This will generate a License

Key.
Transfer License

To transfer the license of the program, copy the Registration ID from the target
computer and paste It below. Click on "Transfer In" to generate a License Key which
needs 1o be pasted in target computer,

Registration 1D (7CLNBKBP-FLTE48TF3MXX3B2X-AEDYONYIATBEX6GM-54D2
License Key : | XXX -XXXK - XXX -XXXX-X XXX

Click here to know the steps of transferring license to another computer,

Cancel

5. You can also save the License Key generated on the source computer. Click Save to File button to
save the Registration ID and the License Key. In Browse for Folder dialog box, select the location

where you want to save the details. Click OK.

6. ' License Key has been saved successfully ' message is displayed after the saving process is

completed successfully. Click OK.

This will deactivate the product on Source Computer and you will no longer be able to use the software

anymore on this computer.

On Target Computer:



1. Type the License Key which you have generated on the Source Computer in the provided field of

License Key.
Offline Registration

You nead bo send below Ested "Registration 1D to "Stellar Technical Support’ ko gat your
Licensa Kay'. If you have already received your Licanse Kay'. enter it and chick
Raegister butlon 1o register the product.

Registration 1D 1E3A344Y TOLNEREP-FLTEAE TRINICEEZX-AED YON YIATAEXEGM-1A32

License Key. R YR B N 3

Cancel |

2. Click Register to complete the activation process.

3. ' Activation Completed Successfully ' message is displayed after the process is completed

successfully. Click OK.



Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://stellarinfo.com/support/

For price details and to place the order, click http://www.stellarinfo.com/email-repair/olm-repair/buy-

now.php

Chat Live with an Online technician at http://stellarinfo.com

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb.php

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

E-mail to Stellar Support at support@stellarinfo.com.

Support Helpline
Monday to Friday [ 24 Hrs. a day ]

USA (Tollfree- Pre Sales Queries) +1-877-778-6087
USA (Post Sales Queries)  +1-732-584-2700
UK (Europe) +44-203-026-5337
Australia & Asia Pacific  +61-280-149-899
Netherlands Pre & Post Sales Support  +31-208-111-188
Worldwide  +91-124-432-6777
Email Orders  orders@stellarinfo.com



http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-repair/olm-repair/buy-now.php
http://www.stellarinfo.com/email-repair/olm-repair/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb.php
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com.
mailto:orders@stellarinfo.com

Select and Repair OLM Files

To select OLM file to be repaired, follow the steps given below:

e Launch Stellar Phoenix OLM Repair - Technician. Select OLM File dialog box opens as shown

below:
[ FaNa! Select OAM File

Browse
Find OLM
To repair a corrupt OLM File, follow the steps mentioned below :
1. Click 'Browse’ button 1o select corrupt OLM file

2. Click "Scan Now" Button 1o Initiate repair process.

Select OLM File dialog box can also be opened by clicking Open icon on the application toolbar or by

choosing Open File option from File menu.

e Click 'Browse' button. Open dialog box is displayed.
e Select OLM file to be repaired. Click Open button.
e The selected file path is displayed in Select OLM File dialog box.
To find OLM file, follow the steps given below:
e Launch Stellar Phoenix OLM Repair - Technician. Select OLM File dialog box opens.
e Click Find OLM button. Find OLM dialog box is displayed.
e From the Look In drop down list select the drive in which you want to search for OLM files.
e Click Find in Folder button to select a specific folder in the selected drive to find OLM files.

e Click Start button. A list of OLM files found is displayed as shown below:



& » Find QLM

Lok In & Lion B St
Find in Folder Srop
Mame Sign Created

Modumes fLion/dlired Lolm 347 MB Thu Jul 21 15:08:42 2016
Molumes fLion fallred 222 .cdm Thu jul 21 15:08:50 2016
Modumes fLion/allinfo .ol m 3 MR Thu jul 21 15:08:50 2016
Nodumes Lion/drafs.slm 470 Kk Thu jul 21 15:08:50 2016
Modumes fLanjim_beggs_ariginal.alm 930 MB Thw Jul 21 15:049:08 2016
MNodumes fLsan/new.clm 2GB Thw jul 21 15:09:58 2016
Modumes fLion/Outlook Mail for Mag Archive.olm 933 MB Thu jul 21 15:10:17 2016
oK Clear List Clase

e Select the desired OLM file from the list and click OK.
To repair OLM file

Click on the Scan Now button to start repairing process. A process progress box is displayed showing

the repair progress.

e @ Select OLM File
fUsers raw Desktop /untitied folder /Rozer.oim Browse
Find OLM
To repair a corrupt OLM File, follow the steps mentioned below :
1. Click 'Browse’ button 10 select corrupt OLM file.
2. Click ‘Scan Now’ Button 10 Initiate repair process.

A summary message box showing the repaired details is displayed after repairing process is completed.



'@ © @ Stellar Phoenix OLM Repair

Your Outlook Backup(OLM) File has been
successfully repaired. Stellar Phoenix OLM
Repair was able to repair the following items:

Repaired Details:
Mails : 23295
Contacts : 283
Calendars : 11228
Notes : 7
Tasks : 103

You can preview the repaired items before saving. To save the
file, choose the save button.

Click Close button to close the summary message box.




Preview Repaired File

Before saving the repaired OLM file, the repaired file data can be previewed. The data that can be
previewed are e-mail folder and its content, address book, calendar, notes, and tasks. The left-frame of
the preview window shows all the folders in the mail box. The centre-frame shows the items in the

selected folder. The right-frame in the preview window shows the content of the mail selected in the

centre-frame.
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Date: Wed, 21 Sep 2005 01:04:56 AM

Dale,

1 have tried to call both numbers listed below but it just
keeps ringing, Could you please call me and we can get
everything locked in,

Thanks,

John Stotz

AVP-Foreign Exchange

LaSalle Bank

540 West Madison Street, Suite 2800
Chicago, IL 60661

312.904,5460

877.534,4559 wll free
312.904.4313

“Dale Hair

<enalipeemcacom> To <JOHN STOTZEABNAVRD,COM>
©

09/20/2005 02 26 M Susject. Eure

To preview the recovered Mail,

e Click on the Mail button on the tool bar as shown in the figure below,

or

e Navigate to View menu and click the Mail option. Click on the Inbox folder in the left frame, then

click on the desired mail in the centre-frame. The mail message is displayed in the right-frame of

the preview window.

To preview the Address Book:

e Click on the Address Book button on the tool bar as shown in the figure below,

or



e Navigate to View menu and select Address Book option. The left-frame of the preview window
shows the Address Book folder. Centre-frame shows list of the Names. Click on the desired

Name to view its detail in the right-frame.
To preview the Calendar:
e Click on the Calendar button on the tool bar as shown in the figure below,
or

e Navigate to View menu and select Calendar option. The left-frame of the preview window shows
the calendar folder. Centre-frame shows list of events. Click on the desired event to view its detail

in the right-frame.
To preview the Notes:
e Click on the Notes button on the tool bar as shown in the figure below,
or

¢ Navigate to View menu and select Notes option. The left-frame of the preview window shows the
Notes folder. Centre-frame shows list of Notes. Click on the desired Note to view its detail in the

right-frame.
To preview the Tasks:
e Click on the Tasks button on the tool bar as shown in the figure below,
or

¢ Navigate to View menu and select Tasks option. The left-frame of the preview window shows the
Tasks folder. Centre-frame shows list of the Tasks. Click on the desired Task to view its detail in

the right-frame.

Note: Preview of images embedded in mail is not displayed.



Save Repaired Files

Stellar Phoenix OLM Repair - Technician provides you with the option to save the repaired OLM files in
Entourage Archive (.rge), Apple Mailbox (MBOX), EMLX, EML and HTM formats.

To save the repaired file, follow these steps:

e Click Save button or select Save option from File menu on the main user interface of Stellar

Phoenix OLM Repair - Technician.
e A Save As dialog box is displayed.

e From the given list of formats, select the format in which you want to save the repaired OLM file
and click OK.

¢ While saving in Entourage Archive (.rge) format, select the location where you want to save the

file. The repaired file will be saved by the name Main Identity (Date,Time).rge.

e In case of other formats (MBOX, EMLX, EML and HTM) select the location to save the repaired
file. The repaired files are saved in a folder created by the name of Repaired Data (Date,Time)

at the selected location.

You can click Stop 0 button in the dialog box to stop the file saving process.

To save a particular folder, select its respective checkbox from the Preview pane and follow the saving

procedure as mentioned above.
Note: Files saved in Entourage Archive (.rge) format can be imported in MS Outlook.

Note: You can view saved files in MBOX, EMLX, EML and HTM format using their respective application.



Import Mailbox Items in Outlook

Stellar Phoenix OLM Repair - Technician saves repaired OLM file with name Main Identity

(Date,Time).rge by default. To import this file in Microsoft Outlook, follow these steps:

e Start MS Outlook.
e Click on Import option in the File Menu.

e InlImport option Begin Import, select Entourage information from an archive or earlier

version and click next.
e Select .rge file in what would you like to import option and click next.

e Select the path where you have saved the repaired file i.e. Main Identity (Date,Time).rge and

click Import.
e You will see Outlook is now importing your data, click Done when import is completed.
e You will see Main Identity (Date,Time).rge in left pane of MS Outlook.

e You can now see all your recovered items under that folder.



FAQs

1. What does the demo version of the software do?
The demo version of the software only shows the preview of repaired mails. To save repaired

mails, you need to purchase and register the software.

2. What is .OLM file type?
File with extension .OLM contains backup of Outlook data such as mails, address book, calender,

tasks, and notes.

3. Can | repair multiple .OLM files simultaneously using Stellar Phoenix OLM Repair -
Technician?
No.

4. Can | save repaired .OLM file by extension other than .rge.
Yes. The repaired files can also be saved in MBOX, EMLX, EML and HTM formats.

5. Can | save selective items from a repaired OLM file?

Yes.

6. Preview of mails in languages other than English is only junk. How to be sure that these
mails have actually been repaired?
Though you are not able to see preview of mails of other languages, be sure that they have been
repaired successfully. To view the mails correctly, import the repaired .rge file into Microsoft
Outlook.

7. Images embedded in mails are not seen in preview. How to see them?

To view the embedded images, import the repaired .rge file into Microsoft Outlook.



Legal Notices

Copyright

Stellar Phoenix OLM Repair - Technician software, accompanied user manual and documentation are
copyright of Stellar Information Technology Private Limited with all rights reserved. Under the copyright
laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar
Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use

of the information contained herein.

Copyright © Stellar Information Technology Private Limited. All rights reserved.

Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject

to change without notice.

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED,
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES,
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE

THEREOF.

Trademarks



Stellar Phoenix OLM Repair - Technician® is a registered trademark of Stellar Information Technology

Private Limited.
Mac OS X® is a registered trademark of Apple Computers.
All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their respective

companies.



License Agreement

Stellar Phoenix OLM Repair - Technician

Copyright © Stellar Information Technology Private Limited. INDIA

www.stellarinfo.com

All rights reserved.

All product names mentioned herein are the trademarks of their respective owners.

This license applies to the standard-licensed version of Stellar Phoenix OLM Repair - Technician.
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by Stellar Information Technology Private
Limited.

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or
use any copy of Stellar Phoenix OLM Repair - Technician with which this License is included, you may
return the complete package unused without requesting an activation key within 30 days after purchase

for a full refund of your payment.

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Stellar Phoenix OLM Repair - Technician. For purposes of this License, if you have a valid single-user
license, you have the right to use a single Licensed Copy of Stellar Phoenix OLM Repair - Technician. If
you or your organization has a valid multi-user license, then you or your organization has the right to use
up to a number of Licensed Copies of Stellar Phoenix OLM Repair - Technician equal to the number of

copies indicated in the documents issued by Stellar when granting the license.
Scope of License

Each Licensed Copy of Stellar Phoenix OLM Repair - Technician may either be used by a single person
or used non-simultaneously by multiple people who use the software personally installed on a single

workstation. This is not a concurrent use license.

All rights of any kind in Stellar Phoenix OLM Repair - Technician, which are not expressly granted in this
license, are entirely and exclusively reserved to and by Stellar Information Technology Private Limited.
You shall not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative
works based on Stellar Phoenix OLM Repair - Technician nor permit anyone else to do so. You shall not
make access to Stellar Phoenix OLM Repair - Technician available to others in connection with a service

bureau, application service provider or similar business nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations


http://www.stellarinfo.com/

Stellar Phoenix OLM Repair - Technician and all accompanying software, files, data and materials are
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You
acknowledge that good data processing procedure dictates that any program including Stellar Phoenix
OLM Repair - Technician must be thoroughly tested with non-critical data before there is any reliance on
it and you hereby assume the entire risk of all use of the copies of Stellar Phoenix OLM Repair -
Technician covered by this License. This disclaimer of warranty constitutes an essential part of this
License. In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix OLM
Repair - Technician in applications or systems where its failure to perform can reasonably be expected to
result in a significant physical injury or in loss of life. Any such use is entirely at your own risk and you

would not hold Stellar responsible for any and all claims or losses relating to such unauthorized use.

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special,
incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information, or any other pecuniary loss)
arising out of the use of or inability to use the software product or the provision of or failure to provide
support services, even if Stellar Information Technology Private Limited has been advised of the
possibility of such damages. In any case, Stellar Information Technology Private Limited’'s entire liability

under any provision shall be limited to the amount actually paid by you for the software product.
General

This License is the complete statement of the agreement between the parties on the subject matter and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the
State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries
of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any
violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or

future violation of the same provision or any other provision of this License.

Copyright © Stellar Information Technology Private Limited. All rights reserved.



About Stellar

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data Protection

Software for more than a decade.

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for

almost all Operating Systems and File Systems.

Product line:

Data Recovery

A widest range of data recovery software that helps you recover your valued data lost after accidental

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >>
File Recovery

The most comprehensive range of file undelete and unerase software for Windows and MS office repair

tools. More Info >>
Email Recovery

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook
Express and MS Exchange useful in instances of data loss due to damages and corruption of Email.

More Info >>
Data Protection

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure

complete data protection against hard drive crash. More Info >>
Data Sanitization

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives,
System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >>

For more information about us, please visit www.stellarinfo.com.
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